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DI Viewer  

DI Viewer is the display log software from Geoprobe Systems®, which can display and print EC, MIP, OIP, HPT, 

and CPT logs as well as MIP response and HPT dissipations & static water level data.  Cross sections with 

multiple logs can also be created with the DI Viewer (Figure 1). 

 

 

Figure 1: A cross section of four MIP-EC logs.  Electrical conductivity is shown in red while      MIP-PID 

detector response is shown in green.   Cross sections like this help the user to understand the 

distribution and mobility of contaminants in the subsurface. 

 

Display & Graphing Features 
 

DI Viewer has three log view options: 

• Single Log will allow the user to view any of the graphs associated with a single log.  A different group 

of graphs will be opened by default depending upon the type of log is being opened.  This is the 

default viewing format when the program is started. 

• Overlay allows the user to compare the graphs between different logs.  This is often done with logs 

performed in close proximity to one another or at the same location before and after a remediation 

event. 

• Cross Section allows the user to compare up to two graphs for multiple logs.  This is used to compare 

a series of logs that have been performed to see how lithology, permeability or contaminant 

readings change across a site.  This tool allows a quick visual for assisting in locating where 

subsequent logs need to be placed or where confirmation samples need to be collected. 
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Access the Log Displays by either: 

• Selecting the display desired from the tool bar.  

• Use the quick keys F9 – Single Log, F10 - Overlay or F11 Cross Section. 

• Or select View above the toolbar and select the desired log display (Figure 2). 

 

Drop-down menus, pop-up menus and adjusting scales: 

Many DI Viewer functions can be accessed from drop-down menus at the upper left of the screen.  Additional 

functions are accessed by moving the cursor over any graph and right clicking the mouse.  The scales on 

vertical and horizontal axis can be adjusted by placing the curser over the max or min value, double-clicking 

the mouse and entering the desired value. 

 

Switching between English and Metric units: 

 

This will switch the depth scale between feet and meters, rate of push (ROP) scales between ft/min and 

m/min, and pressure scales between PSI and kPa.  Scales that do not change: EC - mS/m, MIP Temperature - 
oC, Flow - ml/min, Detectors - V. 

1. Select the View tab of the toolbar  

2. Select Units 

3. Select either English or Metric (Figure 2). 

 

Figure 2: Changing Scaling Units between English and Metric  
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Software Version: 

 

This section helps the user to know which version of software they are operating on their computer.   

1. Select the “Help” tab and then “About” (Fig. 3). 

2. This will display the Version number. In this case it is Version 3.4 and build 19312. 

 

  

 

 

 

 

 

 

Figure 3: Accessing the software version and build numbers 

 

Previous Logs Section: 

The left side of DI Viewer displays all logs that have been previously opened for viewing (Fig. 4) until they are 

removed from this section.  Below are features built within this that allow for easy log access. 

1. Opening logs can be done by either the green plus (+) symbol in this section or by the “File - Open” 

or open folder graphic. 

2. Logs can be added one at a time or in groups into this 

section. 

3. To view a new log, select the log from the list by a 

single left mouse click on the name which will highlight 

it and display in single log view. 

4. Logs can be removed from this section by checking the 

box next to a specific log and then selecting the trash 

can on the upper right of this section or all logs can be 

removed by selecting the red X. 

5. Logs that are displayed can be reorganized 

alphabetically by selecting the A-Z down arrow or 

inversely by selecting it again.   

      

       Figure 4: Previous Log Section 

6. Log Preview: Select the magnifying glass which  

Turns on (or off) the log preview screen then mouse over the log name in the Previous Log section.  

This will pop up a preview (Fig. 5) of the first 3 graphs displayed in single log view. 

7. To minimize this section, select the 3 left arrow tab on the right side half way down the section. 
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Figure 5: Log Preview  

 

Moving Graphs: 

This lets the user move graph panels to the left or right. 

1. Right click the mouse over the graph or log that is desired to move 

2. Select Move Graph left or right from the top of the list of options (Figure 6). 

 

Figure 6: Moving Graphs Left or Right 
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Primary and Secondary Data Series: 

 

Using both the primary and secondary data series enables the user to plot two data series on one panel 

of a log for comparison purposes.  The primary series of the graph is plotted along the X axis at the top of 

the graph.  The secondary series is plotted along the X axis visible at the bottom of the graph.  The 

secondary series is color coded between the graph line and the color of the graph scale and labels on the 

bottom of the graph.  The secondary series is not available in overlay log display.   

 

Changing the Primary or Secondary Data Series – Single Log Display 

1. Right click the mouse over the graph desired to change. 

2. Select Primary Series or Secondary Series (Figure 7). 

3. Select the desired data series to plot. 

4. Select None on the secondary series to remove this graph. 

 

Changing the Primary or Secondary Graph Series – Cross Section Display 

1. Select the primary at the bottom left of the screen (Figure 3) which defaults to EC. 

2. The secondary series is to the right of the primary and defaults to none. 

3. Change by clicking on the dropdown tab and select the appropriate graph to view. 

 

 

Figure 7: Selecting Primary or Secondary Series in Single Log Display 
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Adding a Graph in Single Log and Overlay Display 

1. Select the Add Graph button in the lower right corner of the screen (Figure 10). 

2. Select the graph that is desired to add. 

3. In Single Log display, the option to add a graph to the primary series as well as to the secondary 

series is provided in the lower right corner.  In overlay display, the option to add a graph will be met 

with a list of graphs to add. 

 

Replacing a Graph in Single Log Display 

1. Right click the mouse over the graph that is desired to be replaced. 

2. Select Primary Series. 

3. Replace with desired graph. 

 

Removing a Graph 

1. Right click the mouse over the graph desired to remove. 

2. Select Remove Graph which is just under the Move Graph option. 

 

Changing Graph Panel Widths 

1. Scroll over the edge of the graph panel until the cursor arrow turns into a cross hair. 

2. Left click the mouse, hold and drag the panel edge to the desired width. 

3. To return to even graph widths select the Graph tab and Reset Sizes. 

 

Changing Graph Orientation 

1. The default graph orientation is a vertical log with the depth parameter on the Y axis.   

2. To change graph orientation, select the Graph tab on the tool bar. 

3. Select Orientation and select either Horizontal or Vertical (Figure 8).   

 

Figure 8: Changing graph orientation between vertical and horizontal places the depth on the X axis. 
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Editing MIP Detector Names 

The MIP detector names will be populated from the names listed in the .NFO file of the log, which were 

assigned by the field operator in the DI Acquisition software.   

1. To change the names select the Tools tab  

2. Then select Edit MIP Detector Names… 

3. Enter new names for the detectors.  

 

Logarithmic Graph Scales  

When viewing a cross section that contains detector graphs that range from clean to heavily 

contaminated the user can choose to use logarithmic graph scales to a different view of the data.  This is 

done by placing a check in the Use Logarithmic Scales box at the bottom center of the cross section 

display screen.  This view provides the same data just displayed differently and should be used in 

conjunction with Synched Graph Scales described earlier.  This is most useful when comparing detector 

data which has a wide range of contaminant levels. 

 

Log Merge Function 

This allows the user to join two logs together which must be of the same log type – MIP, EC, HPT or 

MIHPT.   

1. Select the Tools tab and then Log Merge. 

2. Select Log Merge which will pop up a text box (Figure 9).  

3. Select the two logs that are desired to merge together by selecting Browse and searching for the 

desired log file.  Log 1 will be the log nearest the ground surface and log 2 will be the deeper section 

of the newly formed log. 

4. Output Log is the save location and name the new log. 

5. Select Process to execute. 

6. The .NFO file of the new log will state that the new log is a merged log and will provide the names of 

the two original logs.  The .NFO file will also provide the full .NFO Files of the 1st and 2nd logs used to 

create the merge log.  

 

Figure 9: Pop up test box for the Log Merge Function 
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Importing CPT Data into the DI Viewer 

CPT data that generates a Geotech brand data file *.cpt format can be imported into DI Viewer.  Here at 

Geoprobe® we offer Geotech brand NOVA and standard CPT equipment which can be operated stand alone 

or in tandem with MIP or HPT tools.  The DI Viewer CPT import application was designed for our tandem MIP-

CPT tools.    

1. In Single Log display, open the MIP or HPT log that was run with CPT. 

2. Select File and then Import CPT data… 

3. Select the CPT log file that is associated with the open MIP or HPT log file. 

4. Select Add Graph with the cursor in the lower right corner of the viewer screen. 

5. The CPT data will be available in either the Primary or Secondary series tabs to view.  This is available 

in any of the displays. 

6. CPT data series that are open in Single Log display will be available to open in Cross Section or 

Overlay display, however additional logs on those multi-log displays will need to have the CPT data 

brought in for each log by hovering the cursor over the graph window and right clicking the mouse, 

then selecting to add CPT data and select the log file. 

 

Creating Overlays for Log Comparison 

The overlay log display is often used as a log QC function on logs performed in close proximity to one 

another.  It can also be used to evaluate the success of a remediation event with logs performed before and 

after a remediation event. 

1. To view logs in Overlay display, choose overlay then select the Add Logs tab in the lower right corner 

(Figure 10). 

2. Select the logs desired to overlay. 

 
Figure 10: An Overlay of three MIHPT logs showing left to right: electrical conductivity (EC),  

HPT Injection Pressure, PID Detector Response and FID Detector Response. 
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Creating a Cross Section 

 

Cross Section allows the user to compare up to two graphs for multiple logs.  This is used to compare a series 

of logs that have been performed to visualize contaminant distribution and mobility in the subsurface. This 

tool allows a quick visual for assisting in locating where subsequent logs need to be placed. 

1. To create a cross section select cross section display and the add log button in the center of the 

screen. 

2. Select the desired logs to view. 

3. Select different graphs to overlay by choosing the appropriate graphs under primary and secondary 

series in the lower left of the screen (Figure 11). 

 

 
Figure 11: A Cross Section of four MIP logs.  Electrical conductivity is shown in red  

while the PID detector Response is shown in green.  

 

 

Synching Graph Scales in Cross Section Display 

When multiple logs are initially opened in the cross section display, they typically will auto scale to the 

maximum value of each opened data series.  In auto scale, a log with little contaminant may look similar 

to one with ten times the contaminant.  To ensure a clear perspective of relative amount of contaminant 

present across the site, check the box Synch graph scales in the lower left corner of the screen just to the 

right of the secondary series dropdown tab (Figure 11).   
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Graph Properties 

Access the graph properties menu by right clicking anywhere on a desired graph and select Graph 

Properties. 

1. X Axis Tab: Change the scale (min and max) of the X axis. 

2. Y Axis Tab: Change the scale (min and max) of the Y axis. 

3. Grid Tab: Change Grid line Color, Visibility and Spacing. 

4. General Tab: Change Background Color and X Axis Orientation (Figure 12) 

 

Figure 12: Changing Graph Properties 

5. Data Series Tab: Double mouse click on the data series shown in the box.  This will open the 

graph line properties, which is also accessible by right mouse clicking on a graph line data point 

and selecting Series Properties. 

6. Line Tab: Change the graph line Visibility with the check box, Color with the dropdown menu, 

Style with the dropdown menu and line Thickness with the slide bar.   

7. Fill Tab: Make the graph fill Visible with the check box, choose a fill Color with the dropdown 

menu, and change its transparency level with the slide bar. 

8. Points Tab: Make the data points Visible with the check box, change their shape, color and 

outline color with the dropdown menus and adjust their size with the slide bar. 

9. Scrolling over a data point on a graph line such as EC (Fig. 13) and right clicking the mouse scroll 

down to and select Series ‘EC’ Properties (Fig. 14).  This will quickly open the ability to edit Line, 

Fill and Points settings. 
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       Figure 13: EC data point text box   Figure 14: Series EC Properties 

 

Saving graph Layout Settings as Default 

1. Select the Graph tab, Default Layouts, Set Current as 

Default  

2. Save defaults: selected graphs and order, line and color 

settings for a specific DI mode can be exported and 

imported onto different computers (Fig. 15). 

a. Select Default Layouts and Export Defaults 

b. On a different computer select Import Defaults 

and load new settings.   

     

      Figure 15: Default Layout Settings 
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Making Quick Graph Scale Changes 

1. Quickly reduce a graph scale by moving the cursor over a graph visible scale number and right 

clicking the mouse.  Select one of the top choices that will set that axis scale level to either minimum 

or maximum value (Figure 16). 

2. Another way is to move the cursor over the minimum or maximum graph scale value and double 

click the mouse which will highlight this value.  Now type the desired value in its place i.e. if the 

depth scale is listed as 0 to 18 feet highlight the 18 and type 20 and hit enter. 

3. Select Auto Scale (Control + A) next to Print Preview on the tool bar, to resetting the graph scales DI 

Viewer assigned limits. 

 

Figure 16: Making a quick graph scale change 
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User Defined Data 

Elevation 

Logs will default to begin with a depth of zero and increase accordingly to the termination depth of 

the log.  However, if there is a known elevation for the log this information can be inputted to the 

file.  Elevation can be acquired through GPS data or manually inputted in the data set.  To manually 

enter the elevation: 

1. Select Log Elevation in the lower left of the screen, right of the log file name. 

2. Select a log to add/change elevation for – highlighted in blue (Figure 17). 

3. Type in the correct elevation value. 

4. Click OK. 

 

Figure 17: Editing log elevation values 

 

Custom Data Sets 

This allows the user to add data series that pertain to a particular log, such as Lab analytical data 

received back from MIP Log confirmation samples taken.  Now with the addition of adding custom 

data sets the user can add this data into the .zip file and open that data alongside the MIP detector 

data. 

1. To add custom data sets, select the Tools tab and Custom Data Sets. 

2. Select the desired log file to open and/or save custom data sets to.  This will open any existing 

custom data sets as well as assign the path for newly created custom data sets to save. 

3. The next popup screen is the Custom Data Editor screen which will allow for new data to be 

entered, edited, and deleted. 

4. Select the desired data set or select Add for the EditData text box (Figure 18). 

5. Enter the data type and the units associated with the custom data.  Then enter the depth either 

in FT or M (whichever one is entered the other will back calculate) and the amount or 

concentration associated with that data point (Figure 18).  Select OK. 

6. Enter more data if desired and then select Done. 
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7. The new custom data can be added into the display by selecting Add Graph to display it or 

adding a secondary graph along one of the other data series such as the PID (Figure 19). 

8. All graph properties (line weight, fill, color, and point style) of custom data sets can be adjusted 

in the same fashion as other data series (Figure 12). 

 

Figure 18: Entering Custom Data Sets into the software. 

 

 

Figure 19: The addition of the custom data set TCE overlaying the PID in green. 
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HPT Functions: 

When HPT logs are run water is injected through a small screened port on the side of the probe into the 

formation.  The HPT system provides logs of the pressure required to inject water into the formation and 

flow rate that the water was injected as well as the electrical conductivity log obtained simultaneously 

(Figure 20). These logs are run to obtain information about formation lithology and permeability.  There are 

several useful post log processing steps that can be done with the DI Viewer to provide additional 

information about the subsurface conditions at the site.   

 

Figure 20: A typical HPT log displaying (l to r) EC, HPT pressure and injection flow rate. 
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Viewing an HPT Dissipation Test: 

During an HPT log probe advancement is stopped, usually in a sandy layer where HPT injection pressure is at 

its lowest, and a dissipation time file is started to record the pressure changes after the HPT flow is stopped.  

Follow these steps to view a pressure dissipation test and select the stabilized hydrostatic pressure: 

1. Move cursor to lower right of the Viewer window and click on the View icon (Figure 21) 

2. Click on the Dissipation option (if no dissipation tests were run this option will not appear)  

3. The HPT Dissipation window opens to the first dissipation test run for the log 

 

 

 

 

 

Figure 21: Opening a dissipation test file for review. 

 

Note: There must have been at least one pressure sensor Reference Test run, either before or after the log, 

so that dissipation tests can be used to determine the static water level, Corrected HPT pressure and Est. K 

logs.  See the section on User Edited Static Pressure Nodes below for information on how to edit or add a 

pressure value to a log.  

HPT Flow off 

Stabilized hydrostatic pressure 

Flow on 
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Selecting the Stabilized Hydrostatic Pressure: 

1. Move cursor over the pressure line to a location where the pressure has stabilized. 

2. A small window pops up showing the time and pressure at the selected point. 

3. Click on the point and a popup menu opens, click on the option Set as hydrostatic pressure value for this 

test (Figure 22).  A small box is then posted on the selected point. 

 

 

 

 

  

Figure 23: Selecting dissipation tests run at 

different depths during one HPT log. 

Selecting Dissipation Tests 

For many HPT logs dissipation tests will be 

run at several depths (Figure 23).  To select 

the desired test: 

1. Move the cursor over the depth icon 

located at the lower right of the 

dissipation test window. 

2. Click on the down arrow to open the 

depth window. 

3. Move the cursor over the desired test 

depth and click to open that test. 

4. Repeat the steps above to select the 

stabilized hydrostatic pressure for the 

selected test depth. 

 

Figure 22: Selecting a stabilized hydrostatic pressure 

point in a dissipation test window. 
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HPT Hydrostatic Pressure Plot: 

When the first stabilized hydrostatic pressure is selected in the HPT Dissipation test window a new graph 

pops up onscreen.  This is the HPT Hydrostatic Pressure plot (Figure 24).  As additional points are selected 

from other dissipation tests for that log, they are added to the Hydrostatic Pressure plot.  In a water table 

aquifer these points will usually plot as a straight line.  If a data point from a test that was not fully dissipated 

is added to the plot it can be removed.  To remove a point: 

1. Move the cursor over the desired point until a small window with depth and pressure pop up. 

2. Right click on the desired point. 

3. A new popup menu opens.  Use the cursor to click on the option Remove point from the Hydrostatic 

Pressure display 

 

Figure 24: Hydrostatic pressure plot showing several dissipation test points plotted (line  

added to highlight stabilized point alignment).  Click on any point to access popup menu.   
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Plotting Absolute Hydrostatic Pressure: 

After selecting one or more stabilized hydrostatic pressures from dissipation tests in a log (see above) the 

user may plot the absolute hydrostatic pressure line on the HPT pressure graph.   

1. Move the cursor anywhere over the HPT Pressure graph and right click your mouse.  

2. When the popup menu opens select Secondary Series from the list (Figure 25).   

3. Another popup menu opens, now click on Abs. Hydrostatic Pressure. 

When the second selection is made the log will update and the absolute hydrostatic pressure line will be 

plotted over the HPT pressure graph (Figure 26). 

 

Figure 25:  Accessing popup menus from the HPT pressure graph to  

plot the absolute hydrostatic pressure line over the HPT pressure graph. 
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Figure 26: HPT log with the absolute hydrostatic pressure line (blue fill)  

plotted over the HPT pressure log. 

The depths where dissipation tests were run (and hydrostatic pressures were selected) are plotted as solid 

triangles on the line.  Where the hydrostatic pressure line intersects the atmospheric pressure (static water 

level) a red circle is plotted.   
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Corrected HPT Pressure and Est. K Log:  

To view the Corrected HPT Pressure graph:  

1. Right click on a graph and select the Primary Series option (Figure 26).  This will replace the existing 

HPT Flow graph with the Corrected HPT Pressure graph.  Alternatively, you can select the “Add 

Graph” tab in the lower right corner of the screen. 

2. On the second popup menu click on the Corr. HPT Press. option.  

The log plot will be updated, and the corrected HPT pressure graph will be plotted (Figure 27).  The corrected 

HPT pressure is calculated by subtracting the atmospheric + hydrostatic pressure from the Average HPT 

Pressure log at each depth increment.  This provides a plot of the pressure required to inject water into the 

formation at each depth increment along the log.   

 

 

 

Figure 27: HPT log with corrected HPT Pressure graph (right). 
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Once the absolute hydrostatic pressure line has been determined the user may plot a graph of the estimated 

hydraulic conductivity (Est. K) for the log.  One option to do this is to add a graph to the plot.   

1. Click on the Add Graph icon at the lower right of the log window (Figure 28) to open the Add Graph 

window. 

2. Next click on the down arrow at the Primary Series option to open the selection menu. 

3. Select the Est. K option from the menu.   

When this is done the log plot updates and the Est. K log is plotted (Figure 29). 

 

 

 

Figure 29: HPT log with the Est. K log added (far right).  The Est. K data is calculated only  

for the saturated formation. Both corrected HPT pressure and flow rate are used at each  

depth to calculate the estimated hydraulic conductivity. 

  

Figure 28:  The command sequence 

used to add a graph to the log.  

Here the Est. K option is selected 

for plotting. 
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Incomplete Dissipation Tests: 

 

Dissipation tests are usually run in sandy/coarse grained formations so the pressure will dissipate quickly and 

minimal time is needed for the test, often less than 100 seconds.  Sometimes a dissipation test is run in a 

fine-grained zone just to confirm that pressure dissipation is slow and the formation has lower permeability.  

Many of these tests are run for a few minutes and then stopped before the induced pressure fully dissipates 

(Figure 30).  Pressure dissipation tests in fine grained formations could take many hours to fully dissipate.   

 

Figure 30: Examples of incomplete dissipation tests.  The pressure induced by inserting the probe and 

injecting water into the formation has not fully dissipated in either of these tests.   

  

Induced pressure still rising! 

Induced pressure still falling 
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If one or more of these incomplete dissipation tests is incorrectly used to develop the Abs. Hydrostatic 

Pressure line for an HPT log errors will be introduced and the pressure line will be incorrect, also the static 

water level may be incorrectly plotted.  An incorrect Abs. Hydrostatic Pressure line will also result in an 

incorrect corrected HPT pressure log which in turn will provide an incorrect estimated hydraulic conductivity 

(Est. K) plot for the log (Figure 31).  Carefully review and choose the dissipation tests to be used to develop 

the Abs. Hydrostatic Pressure profile.  

 

Figure 31: An HPT log where incomplete dissipation tests were used to develop the Abs. Hydrostatic Pressure 

line.  This can cause incorrect calculation of the static water level, Corr. HPT Pressure, and Est. K log.  

Compare this log to the correct one in Figure 29 above.   

 

To learn more about working with and interpreting HPT logs review these documents:  

http://geoprobe.com/literature/mk3184-application-of-hpt-for-geo-environmental-investigations  

http://geoprobe.com/literature/tech-guide-for-estimating-k-using-hpt  

 

  

http://geoprobe.com/literature/mk3184-application-of-hpt-for-geo-environmental-investigations
http://geoprobe.com/literature/tech-guide-for-estimating-k-using-hpt
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Adding or Editing Hydrostatic Pressures: 

Sometimes an HPT log is completed without running a dissipation test, or the only pressure dissipation test 

from the log did not fully dissipate.  If there is a monitoring well or a temporary groundwater sampling tool 

installed near the log location the static water level from that piezometer can be used to develop an absolute 

hydrostatic pressure line, corrected HPT pressure, and Est. K plot for the log.  To add or edit static pressures: 

1. Right click anywhere on the HPT Pressure graph to open the popup menu (Figure 32).* 

2. Select the option Edit Static Pressures. 

3. The User-Edited Static Pressure Nodes window opens. 

You can now edit or enter depths and corresponding pressure values in the table.  Example below. 

*If the absolute hydrostatic pressure line is not already plotted on the HPT pressure graph right click on the graph, 

select Secondary Series from the popup menu, then select the Abs. Hydrostatic Pressure option. Now proceed with 

step 1 above. 

Figure 32: Opening the User-Edited Static Pressure Nodes window so static pressures in a log can be 

edited or added.  Also, schematic of a monitoring well that was in place near this log location is 

shown in the EC panel.    

 

Example for Static Pressure Editing: 

An HPT log was run about 7ft (2.1m) from a well.  The well and log location are at the same elevation.  The 

well is screened from 10 to 20ft below grade and the static water level was measured at 3.8ft below grade 

(Figure 26).  From the pre-log reference test the local atmospheric pressure was determined to be 13.30psi 

(Figure 27).  We know that for 10ft of water the hydrostatic pressure rises approximately 4.33psi.  For this 

location at a depth of 13.8ft the hydrostatic pressure would be:  

Well 

Screen 
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 13.30psi + 4.33psi = 17.63psi 

Enter the depth of 13.8ft and pressure of 17.63psi in the table (Figure 33) and click on OK. The Abs. 

Hydrostatic pressure line will be updated in the log.  The corrected HPT pressure can now be graphed and the 

Est. K log can be plotted for the log (Figure 34). 

 

 

 

  

Figure 33: Entering user generated static 

pressures for an HPT log. 

Figure 34: HPT log with user generated static pressure 

edited in so that Abs. hydrostatic pressure line could be 

calculated and plotted.  This also makes it possible to 

calculate the Corr. HPT pressure and Est. K log.  
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Estimating Groundwater Specific Conductance 

 

In logs were HPT has been performed, there is an option to display an estimate for groundwater specific 

conductance.   To display GW specific conductance, a pre-log HPT reference test and an in log dissipation test 

must be performed.  The dissipation test must also be processed in Direct Image Viewer.  The corrected HPT 

pressure must be <5PSI (35kPa) for this graph to display and it possible for a sporadic graph line to be 

displayed if the corrected HPT pressure however above and below 5PSI.  In Fig. 35 we see EC readings jump 

from ~50mS/m to ~500mS/m between 18-22ft bgs.  During this depth interval the HPT injection pressure 

remains low indicating that something other than soil grain size and mineralogy is causing the rise in EC 

readings.  This shows that the readings on electrical conductivity are primarily influenced by the in situ pore 

fluids instead of the soil mineralogy.  The 4th graph shown displays a dramatic rise in Estimated GW specific 

conductance from ~1,370S/cm to over 26,000S/cm.  To display this graph the user will click on “add graph” 

and select “Est. GW Spec. Cond.” Near the bottom of the list. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Figure 35: HPT log with estimated GW Specific Conductance in the 4th graph 

section.   Log includes EC, HPT Pressure with Absolute Piezometric Pressure, HPT 

line pressure with HPT flow and estimated K in the final graph. 
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MIP Functions: 

When MIP logs are run an inert carrier gas (typically nitrogen) is delivered from surface instruments down a 

trunkline to sweep behind a heated semipermeable membrane.  Volatile contaminants (petroleum 

hydrocarbons and chlorinated solvents – typically) are able to diffuse across the membrane into the carrier 

gas stream where they are brought to gas phase detectors at the surface.  When MIP logs are generated 

electrical conductivity and HPT graphs are also typically generated simultaneously.  Most features of the MIP 

logs are generally graphing features found above.   

MIP Response Test 

The Chemical response test is an important test that is performed before and after each log to ensure the 

MIP system from membrane to detectors is working in a well and consistent manner. 

1. View the response test by clicking the curser on the View tab in the lower right corner of the screen. 

2. Select Response Test 

3. Alternately the user can reach the response test file by selecting the Tools tab and then MIP 

Response… 

4. The response test file will default to show detector 1 graph of the Pre/Post Log File.  The software 

will show both the PRE and POST log response test file if both files exist.   

5. To change the current data being viewed select the drop down tab in the upper right corner which 

shows the available data series (Figure 36).  This will change both Pre and Post log graphs.  The 

detectors are listed as they were assigned in the DI Acquisition software by the field operator. 

 

 

Figure 36: Selecting data series in MIP Response test file 

 

6. The Peak response level, located just above the Compound fill in box, defaults to the highest 

response level and includes the baseline level. 
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7. To subtract out the baseline, hover the curser over the baseline prior to the response and right click 

the mouse. 

8. Select Set as Baseline (Figure 37). 

9. Now the value shown to the right of the graph above the Compound box is the detector response. To 

change the baseline level or the response peak point, move the cursor over the data point location 

that should be used as either the baseline level or where the top of the response peak should be 

measured and right click the mouse on that data point.  Now select the appropriate command either 

Set as Baseline or Set as Peak.  To completely remove previously set baseline and peak lines select 

Reset Baseline & Peak. 

 

Figure 37: Setting a Peak Response Baseline & Peak Lines 

10. By selecting Graph Properties or by right clicking on a graph line data point and selecting the Series 

Properties line graph line colors, line weights, fill and data points can be altered just as in the main DI 

Viewer screen (Figure 12). 

11. Selecting Multi Log (F10) on the response test screen will allow the user to overlay multiple response 

tests of similar detector types for comparison. 
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OIP Functions 

Direct Image Viewer offers some interesting features for displaying and analyzing Optical Image Profiler (OIP) 

logs.  Logs from the OIP system may typically contain hundreds if not thousands of saved .jpg images of the 

subsurface soils typically under ultraviolet (UV) light or green light.  These images may display fluorescence of 

NAPL fuels and oils excited by either a UV or green light source contained within the probe.   

 

Single Image Display 

A user can “Add a Graph” and select “Single Image Display” for the graph type. Only one “Single Image 

Display” may be opened.  Click the mouse on the “FLUOR” graph will 

result in a green line across the screen.  The “Single Image Display” 

graph will display the saved image from the depth of the green line.  

The depth of the green line, light source, and % area of fluorescence 

(for UV and Green only) will be displayed above the image (Fig. 38).   

1. The user can hold the up or down arrow key and the curser 

will sift up or down respectively through the saved images 

within the log.  The user can click on a specific depth to 

“jump” to that depth.  

2.  The red dots to the right of the “Single Image Display” 

represent depths where still images were taken. Left clicking 

on a red dot will display a still capture image from that 

depth. The left and right arrow keys will cycle between the 

available images for that depth. Right clicking will allow for 

selecting which still capture is displayed.   

    

 

Figure 38: OIP Log with Single 

Image Display graph 

3. Expanding or shrinking the width of the “Single Image Display”   

will change the number of images displays for the particular  

depth from 1 to 3 images. The available image displays are Captured, Analyzed, and Overlayed. 

Captured displays the image capture by the camera at the particular depth. Analyzed displays a 

representation of where within the image the software identified fluorescence. Overlayed displays 

the image captured with the Analyzed display overlayed. Right clicking the “Single Image Display” 

and selecting “Image Display Properties” will allow for changing which image displays are shown. 

 

Image Analysis 

OIP fluorescence is defined as the amount of the image area (7mm x 10mm) that displays fuel fluorescence.  

When a captured image shows fluorescence the “Analyzed” image will show how much of the image the 

software has determined to show positive fluorescence based upon specific set color filters within the 

software.   The % image area that is fluorescing displayed in Figure 38 is 17.7%. 
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Measuring inside the saved images 

 

In the single image display graph, the user can take their curser and draw lines to 

measure particle sizes (Fig. 39).  The smallest size is 0.1mm.  Measurements are 

not saved on the image.   

Left click the mouse and hold it down as you move the mouse to draw your line to 

make a measurement. 

A user can right click the mouse on the image and select “clear measurements” to 

remove all measurements from the image. 

 

 

 

 

Figure 39: Measuring distances in 

a saved OIP Image file 

Multiple Image Display 

A user can “Add a Graph” and select “Multiple Image Display” as the graph type.  More than one “Multiple 

Image Display” can be added (Fig. 41). 

Right click the “Multiple Image Display” graph and select to add or remove image displays to the graph (Fig. 

40). 

1. To change the image shown by the image display: highlight 

the image display by clicking on it. A blue boarder will 

appear around the active image display. Click on the 

fluorescence graph or use the arrow keys to select the 

depth you would like to be shown by the image display.   

Click twice on the active image display to unhighlight the 

display. 

2. To “deactivate” the image pane double left click on the 

image and the blue highlight will be removed and the user 

can click anywhere on the graph and not have a new image 

populate that image box. 

3. The depth the image came from and the image type is 

indicated by the label directly above each image display in 

the “Multiple Image Display”. 

 

                         

            Figure 40: Multiple Image Display 
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OIP Image Types 

The standard images are captured during advancement of the probe, 20 images per foot.  The speed of the 

tool advancement can produce some motion blur in the captured image. 

Still Images are taken when the probe advancement has been stopped.  Still images are automatically taken 

during the addition of a new rod in the rod string (except in clamp mode). The probe advancement can be 

stopped and still images can be captured at any depth during the advancement of the tool. The software will 

cycle between the available light sources (Ex: UV and Visible light, Green and IR light) to capture “still images” 

for each source when the “capture all” button is pressed in the DI Acquisition software. The depths the still 

images were taken are indicated by the red dots along the right side of the single or multiple image display 

graphs.   

 

 

 

 

 

 

 

 

 

 

Figure 41: Adding a specific visible depth Image to the multi-Image display 

 

 

  



36 
Back to Top 

 

General Log Functions 

Renaming a Log 

 

This feature allows the user to rename an existing log which will rename the outside of the .zip file and all 

files inside the .zip file the same.  If a log has a file named differently inside the .zip file from the outside DI 

Viewer will not recognize the file and provide a bad file error message. 

1. From the “Tools” menu select “Renaming a Log” (Fig. 42). 

2. First Select the log file you would like to rename. 

3. Enter the correct Log name when prompted (Fig. 43). 

4. Now if the log by the old name is loaded into DI Viewer and it is clicked on it will be listed as a bad 

file.  This one must be removed. 

5. The renamed log will be in the original folder only as the new name not by the old name. 

 

 
Figure 42: Pathway to Renaming a Log   Figure 43: Entering a new Log name 

 

 

Printing & Exporting Data 

Print Options 

1. To print select the File tab and then Print. The quick key print command is control-P.   

2. The maximum number of graphs printed per page in portrait format will be 4 and landscape can 

print 6; additional graphs will print on additional pages. 

3. To change the print style between portrait and landscape select File then Page Setup then select 

the desired print orientation style: landscape or portrait. 

4.  When ready to print, the user will need to choose whether they want to print the log and the 

.NFO report or just the log.  This is managed by the check box that states Include INF File (Figure 

44). 

5. If the user wants to use the site information that was entered at the time of logging select Footer 

– Source: .NFO file.  View this in print preview and use the magnifying glass (zoom) to get a 

better look at the footer text.  If a different description for the Log footer information is desired 

select Source: – manually entered (Figure 44). 

6. To preview the printout select File then Print Preview….   

7. The previewed format including the footer site information will also be the format result when 

printed to a PDF.  To print to a PDF select the PDF program loaded on the computer listed under 

Select Printer. 



37 
Back to Top 

8. Change the logo for the printout by selecting Change Logo… (Figure 44).  The company logo must 

be in any picture format.  The logo can also be changed in the Properties Tab which is the second 

icon on the toolbar next to the open folder icon.  To replace the existing logo, select Change 

Logo and direct the computer to the folder where the desired logo is stored.  Select the desired 

logo for the logs. 

 

Figure 44: Selecting Print Options 

 

 

Export Log Graphs 

Export your logs to a JPG, BMP or PNG file.  The exported graph will not contain any site or client information 

as the printouts do.  This is useful for creating log images to be used for presentations and in marketing. 

1. Select the File tab. 

2. Select Export Graph… which will provide a preview of the exported graph (Figure 45). 

3. On the Preview screen select which opened graphs are desired to export (Figure 45). 

4. The software will provide a recommended image and font size 

5. Changing either the font of image size will affect the quality of the end product. 

6. When ready select OK  

7. Select the image type (png, bmp, jpg) in the Save As screen.  This is located in the Save as type box 

under the file name box.  
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Figure 45: Exporting Graph Images 

NFO/INF File: 

This log file holds all of the information about the log including log name, date and log start time and 

final depth.  Stringpot and rod length, probe type, also included in this file is log QA data such as EC tests, 

HPT Reference test and MIP Chemical Response tests.  This file will include the depth that any alarms 

were issued during the log.  MIP detector names and the associated attenuation settings as well as when 

changes were made.  GPS and elevation data is saved here as well as user notes. 

1. This can be viewed by clicking the curser on the View tab in the lower right corner of the screen. 

2. Select INF File… 

3. To print the NFO/INF file make sure that the Include INF File box is checked when going through the 

print process (Figure 44). 

 

MIP Response Test Printing: 

1. Most of the print functions within MIP response test graph printing are the same as in the main DI 

Viewer Log printing however we can now select multiple data series to print on a single page (Figure 

46).  These single page printouts will be of just the Pre or Post log response test and can have a 

maximum of four data series per page. 

2. The response test printout will provide information to the right of the detector graphs showing 

which detector it represents, the baseline level and peak response level, compound used and its 

concentration (Figure 47). 
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Figure 46: Printing MIP Response test graphs 

 

 

 

Figure 47: Pre-Log Response Test Print out 
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Exporting Log Data 

 

This feature allows the user to export only the desired data columns they need for input into 3D 

modeling programs.  The generated file will be a tab separated data file which can be opened with MS 

Excel. 

1. Select the File tab then Export Log Data 

2. A new pop-up textbox will appear which will allow the user to select the data series they wish to 

export.  The textbox has two columns: Available Values and Export Column (Figure 48). 

3. Highlight the data that is desired to be exported by clicking on the data series in Available Values and 

click the right arrow button between the two columns which will move this data series from 

Available Value to Export Column.  Data series can be moved back out of the export queue by 

highlighting them in Export Columns and clicking the left arrow between the columns. 

4. The top to bottom order that the data appears in the Export Columns section will be the left to right 

order the data will appear when opened in MS Excel.  To rearrange this order highlight a data series 

in Export Columns select either the up or down arrow to the right of the Export Columns section. 

5. When the correct data is selected in the format desired select OK. 

6. The user will be asked to name the created file and place it in an appropriate folder.    

 

Figure 48: Text box for selecting data to export under Exporting Log Data 

Export the logs to a JPG, BMP or PNG file.  The exported graph will not contain any site or client information 

as the printouts do.  This is useful for creating log images to be used for presentations and in marketing 

 

 

 

 


